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Any unauthorized reproduction of the Spelling Sentry user’s guide or software is strictly prohibited and 
is a violation of national and international copyright laws. No part of this product may be reproduced or 
distributed in any form, by any means, except as described herein.

SPELLING SENTRY IS PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND. 
WINTERTREE SOFTWARE DISCLAIMS ANY REAL OR IMPLIED WARRANTY WITH RESPECT
TO FITNESS FOR ANY PARTICULAR PURPOSE. WINTERTREE SOFTWARE CANNOT BE 
HELD RESPONSIBLE FOR LOSS OR DAMAGE, DIRECT OR INDIRECT, CAUSED BY THE USE 
OR MISUSE OF THIS PRODUCT.

The Spelling Sentry program, the Spelling Sentry DLL, and the Spelling Sentry user’s guide are © 1993 
by Wintertree Software Inc.

All trademarks used herein are the property of their respective holders.
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Introduction

Wintertree Software’s Spelling Sentry program lets you check the spelling of text files, Windows Write 
files, and text in the Windows clipboard. It comes with a high-quality 80,000-word lexicon (dictionary), 
and includes support for three different user lexicons. It’s fast, easy to use, and reliable. Here are some 
other features:

• Can replace misspelled words in the file or clipboard text they came from
• Displays the sentence containing a misspelled word so you can see how it is used
• Suggests accurate, multi-level alternatives for misspelled words
• Displays word and sentence counts plus Fog and Flesch-Kincaid readability scores
• Can ignore capitalized words (e.g., proper names), except when they occur at the beginnings of 

sentences
• Can detect doubled words
• Can detect words with unusual case combinations
• Can ignore words containing embedded numbers or special symbols
• Can undo the last replacement made in a file or clipboard text
• Includes on-line help
• You can add your own words to the user or supplemental lexicons
• Exclusion lexicon lets you define words which should be considered misspelled, even if they 

appear in the other lexicons
• Progress display shows number of words checked and percent complete
• Easy lexicon editing includes merging lexicons or dictionaries from other applications
• Can check the spelling of individual words
• Supports drag-and-drop file checking

How to Register Your Copy of Spelling Sentry
Spelling Sentry is a shareware program. With shareware, you can try a software package before you buy 
it. This works to your advantage, because you can be sure a software package will meet your needs 
before you purchase it. Shareware works on the honor system: If you find a package useful, you are on 
your honor to send in the registration fee.

Wintertree Software permits you to evaluate Spelling Sentry for a period of 30 days. When the 30 days 
have expired, you must either send in your registration fee or destroy your copy of Spelling Sentry. If 
Spelling Sentry is useful to you, even if you use it only occasionally, we ask that you send in your 
registration fee.

Spelling Sentry is the product of many hours of effort. We’re proud of Spelling Sentry, and we’d like to 
continue to support it and improve it. We can’t do this unless the users of Spelling Sentry show their 
support by sending in the registration fee. Wintertree Software is not a huge corporation with opulent 
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executive offices and millions of dollars of revenue — it’s a small company with a few dedicated, 
enthusiastic employees who rely (in part at least) on registration fees for our shareware products 
Spelling Sentry, Grammar Expert, and WStyle for their personal income. We invested our time and 
resources to produce Spelling Sentry, and we ask that you reciprocate by sending in your registration fee
if you find Spelling Sentry useful.

When you register for Spelling Sentry, you will receive
1. A diskette containing the most recent version of Spelling Sentry (without the shareware notice 

at the beginning)
2. A printed copy of the user’s guide (optional — see order form)
3. The 80,000-word lexicon with your choice of American or British/Canadian spelling rules
4. Mailed notifications of major upgrades to Spelling Sentry, and an opportunity to purchase new

versions and other products at special rates

If you use Spelling Sentry within an organization (e.g., a company), one copy must be registered for 
each person who uses it. Wintertree Software offers the following quantity discounts (prices shown are 
in US dollars):

No. Copies Cost per Copy
1 $25.00
2 - 9 $18.75
10 - 29 $16.50
30 - 49 $15.00
50+ $13.50

To obtain these quantity discounts, please order from Wintertree Software directly.

You can register for Spelling Sentry in three ways:
1. By phone, using a credit card.
2. By mail.
3. Using CompuServe’s Shareware Registration service.

Registering by Phone
You can order your registration of Spelling Sentry with MC, Visa, Amex, or Discover from the Public 
(software) Library by calling 1-800-2424-PsL or (713) 524-6394. You can also order by sending a FAX 
to (713) 524-6398, or by sending CompuServe EMail to 71355,470. NOTE: These numbers are for 
orders only! Any questions about the status of your order, registration options, product details, technical 
support, volume discounts, dealer pricing, site licenses, etc. must be directed to Wintertree Software Inc.
at (613) 825-6271.

When you order by phone, PsL will notify us the day of your order and we will ship the product directly 
to you.
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Registering by Mail
Via check or money order: Fill in the order form on the next page and send it with a check or money 
order for the total amount indicated to:

Wintertree Software Inc.
Attn: Order Dept.
43 Rueter St.
Nepean, Ontario
Canada K2J 3Z9

We accept checks drawn on a US or Canadian bank. We also accept international money orders.

Via credit card: Fill in the order form on the next page and send it to:
PsL
P.O. Box 35705
Houston, TX
USA 77235-5705

Via purchase order: Please call Wintertree Software Inc. at (613) 825-6271.

Registering via CompuServe’s Shareware Registration Service
If you’re a CompuServe subscriber, you can register for Spelling Sentry on-line. CompuServe will add 
the registration fee for Spelling Sentry to your CompuServe bill. To register, just type GO SWREG on 
CompuServe and follow the instructions. Spelling Sentry’s registration id is 1810.
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Spelling Sentry Order Form

Name: ___________________________________________________________________
Address: __________________________________________________________________
City: _________________________________ State/Prov: ___________________________
Country: ______________________________ Zip/Postal Code: _______________________
Phone: _______________________________

Please send me ____ copies of Spelling Sentry: ________
Ontario residents please add 8% PST: ________

Shipping and handling:        $4.00
TOTAL: ________

Diskette Size:
____ 5 1/4"   ____ 3 1/2"

User’s Guide
The Spelling Sentry user’s guide in either paper or electronic form can be shipped with each 
copy ordered. Please indicate your preference:
_____ User’s guide in electronic form (Windows Write file)
_____ User’s guide in printed (paper) form

80,000-word Lexicon
Two versions of the main 80,000-word lexicon exist: one containing American spelling rules, 

and the other containing British/Canadian rules. Please indicate your preference:
_____ American spelling rules
_____ British/Canadian spelling rules

Method of Payment:
____ Check/Money Order     ____ Credit card (Type: _______________)
Card number: _______________________________________________
Expiry Date:  ________________________________________________
Signature: ___________________________________________________

Send Check/Money-Order Orders to: | Send Credit-Card Orders to:
Wintertree Software Inc. | PsL
Attn: Order Dept. | P.O. Box 35705
43 Rueter St. | Houston, TX
Nepean, Ontario | USA 77235-5705
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Canada K2J 3Z9 |
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Special Note to Windows Software Developers

The Spelling Sentry DLL (SPSENTRY.DLL) contains a general-purpose spell-checking engine which is 
available for royalty-free use in your applications. Your application can use SPSENTRY.DLL to

• Check the spelling of words
• Obtain suggested alternatives for misspelled words
• Maintain the user, supplemental, and exclusion lexicons
• Remember Ignore-All/Replace-All words

These features are available to your application when you license the Spelling Sentry DLL.
The Spelling Sentry DLL includes the 80,000-word main lexicon in compressed form, a C/C++ API, 40-
page programmer’s manual, and example source code. An add-on package which allows you to create 
your own compressed lexicons is also available, as is a package containing the 80,000-word main 
lexicon in ASCII text form.

Pricing (effective January 1994, subject to change without notice):
Canadian US.

Spelling Sentry DLL Package $399.00 $299.00
Lexicon compression tool kit $199.00 $149.00
80,000-word lexicon in ASCII form $329.00 $249.00
DLL source code (in C) $779.00 $585.00
Demo disk $5.00 $5.00

To order the Spelling Sentry DLL products, please contact Wintertree Software directly.

- 9 -



Spelling Sentry User’s Guide
Using Spelling Sentry

How to check a file
Spelling Sentry can check the spelling of ASCII text files and Windows Write files. You can check files 
using two methods: from Spelling Sentry’s Check menu and by dragging a file from the Windows File 
Manager.

To check a file using the Check menu
1. From the Check menu, select File.
2. Spelling Sentry displays an Open File dialog. Locate and select the file you wish to check, then 

select the OK button.
3. Spelling Sentry checks the words in the file.
4. Spelling Sentry pauses when it detects a misspelled word so you can correct it. See “How to 

respond to spelling errors” for instructions.
5. When checking is complete, Spelling Sentry saves any replacements made to disk. It also 

displays some statistics (see “Statistics” in the “Spelling Sentry Reference” chapter for details).

To check a file from the File Manager
1. Locate the file you wish to check in File Manager’s window.
2. Drag the file from File Manager’s window onto Spelling Sentry’s window or icon (“drag” means

click and hold the left mouse-button, move the mouse, then release the mouse button). Note: You
can drag a file to Spelling Sentry’s icon only if Spelling Sentry is “minimized” at the bottom of 
the screen.

3. Spelling Sentry checks the words in the file.
4. Spelling Sentry pauses when it detects a misspelled word so you can correct it. See “How to 

respond to spelling errors” for instructions.
5. When checking is complete, Spelling Sentry saves any replacements made to disk. It also 

displays some statistics (see “Statistics” in the “Spelling Sentry Reference” chapter for details).

Notes
You can cancel a spell-checking session by selecting the Stop Checking button.

Spelling Sentry can check files produced by the Windows Write program and ASCII text files. If the file 
you select doesn’t appear to be either of these types, Spelling Sentry will display a warning message 
asking if you want to check the file anyway. Spelling Sentry will attempt to identify words in 
unsupported file types, but bear in mind that it may become confused. Replacing misspelled words in 
these files is not recommended.

How to check the clipboard
You can check the spelling of words in the Windows clipboard.

1. In another application, select the text you want to check, then copy it to the clipboard. You can 
do this in most applications by selecting the Copy item from the Edit menu.

2. In Spelling Sentry, select the Clipboard item from the Check menu.
3. Spelling Sentry checks the words in the clipboard.
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4. When Spelling Sentry detects a misspelled word, it pauses so you can correct it. See “How to 

respond to spelling errors” for more information.
5. When Spelling Sentry is finished checking, it copies any replacements made to the clipboard. 

You can paste the corrected text back into your other application’s document. You can do this in 
most applications by selecting the Paste item from the Edit menu.

Notes
You can cancel a spell-checking session by selecting the Stop Checking button.

How to check a single word
1. Select the Word item from the Check menu.
2. Spelling Sentry displays a form which prompts you to enter a word. Type in the word you want 

to check, then select the OK button.
3. Spelling Sentry displays a message which tells you whether the word is correctly spelled or not.

How to respond to spelling errors
When Spelling Sentry detects a misspelled word while checking a file or the clipboard, it pauses to give 
you a chance to respond. 

The word which Spelling Sentry considers to be misspelled appears in the Misspelled Word field in the 
main window. The words surrounding the misspelled word (usually the sentence in which the word 
appears) are shown in the area near the top of Spelling Sentry’s window.

If you have selected the Always Suggest option, Spelling Sentry searches for alternative spellings for the
misspelled word, and displays any suggested words in the list box. If you have not selected Always 
Suggest, you can select the Suggest button. This will cause Spelling Sentry to search for alternative 
words. If the correct spelling doesn’t appear in the list, try selecting the Suggest button again. Each time 
you select the Suggest button, Spelling Sentry searches its lexicons a little deeper.

Select one of the following actions:
• If the word in the Misspelled Word field is correctly spelled and probably doesn’t occur again in 

the file or clipboard, select the Ignore button.
• If the word is correctly spelled and probably occurs again in the file or clipboard, select the 

Ignore All button. If the word appears again, Spelling Sentry will ignore it.
• If the word is correctly spelled and is a word you use often (for example, your family name), 

select the Add to Lex button. Spelling Sentry will remember the word in the user lexicon.
• If the word is misspelled and the correct spelling appears in the list box, select the correct 

spelling from the list box.

In some rare cases, Spelling Sentry cannot locate the correct spelling for a misspelled word. If this 
happens, you can edit the word in the Correction field manually. To verify that the word in the 
Correction field is correctly spelled, click on the Recheck button. Spelling Sentry will display a message
telling you if the word is correctly spelled or not.
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You can replace the misspelled word with the word in the Correction field by selecting one of the 
following actions:

• If the misspelled word doesn’t occur again in the file or clipboard, select the Replace button.
• If the misspelled word occurs again in the file or clipboard, select the Replace All button. 

Spelling Sentry will replace this occurrence and each subsequent occurrence of the misspelled 
word with the word in the Correction field.

Note: By selecting the Undo Last button, you can undo the last single replacement made to the file or 
clipboard.

How to edit a lexicon
You can edit the words in the user lexicon, supplemental lexicon, or exclusion lexicon. However, you 
cannot edit the words in Spelling Sentry’s main lexicon.

1. Select the item in the Lexicon menu for the lexicon you wish to edit (User, Supplemental, or 
Exclusion).

2. The lexicon-editor dialog appears. Edit the lexicon by following one of the specific procedures in
this section.

3. To close the lexicon-editor dialog, select the Close button.

How to add a word to a lexicon
1. Select the Add button from the lexicon-editor dialog.
2. A dialog appears, prompting you to enter a word. Enter the word you wish to add. The word may

contain alphabetic characters and apostrophes only — no other symbols or digits are allowed. 
Note: Make sure the word is correctly spelled!

3. Select the OK button. Spelling Sentry adds the word to the lexicon.

How to delete a word from a lexicon
1. In the list box in the lexicon-editor dialog, select the word you wish to delete.
2. Select the Delete button. Spelling Sentry removes the selected word from the lexicon.

How to merge two lexicons
You can merge words from one lexicon into another lexicon. You can even merge any set of words into a
lexicon, provided the words are stored in a disk file, one word per line. You can use this procedure to 
merge the user lexicon from another application’s spelling checker (sometimes called the “user 
dictionary,” “custom dictionary,” etc.) into one of Spelling Sentry’s lexicons.

1. Select the Merge button in the lexicon-editor dialog.
2. A file-open dialog appears. Locate and select the file containing the words you wish to merge 

into the current lexicon, then select the OK button.
3. The words in the disk file are merged into the current lexicon.
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How to clear a lexicon

1. Select the New button from the lexicon-editor dialog. Spelling Sentry may display a dialog 
asking if you want to save the current lexicon. If you select the Yes button, Spelling Sentry saves 
the lexicon to disk.

2. All the words in the current lexicon are deleted.

How to save a lexicon to disk
1. Select the Save button in the lexicon-editor dialog.
2. Spelling Sentry copies the word in the lexicon to a disk file.

How to open a different lexicon file
Spelling Sentry saves the user, supplemental, and exclusion lexicons in disk files. Each lexicon uses the 
following default file names:

User lexicon: USERLEX.TXT
Supplemental lexicon: SUPPLEX.TXT
Exclusion lexicon: EXCLLEX.TXT

You can create different lexicon files if you wish. You can also have several sets of lexicon files, each 
for a different purpose; open the lexicon you want to use by following the procedure below.

1. Select the Open button from the lexicon-editor dialog.
2. Spelling Sentry may display a dialog asking if you wish to save the current lexicon. Select the 

Yes button to save the lexicon to a disk file.
3. Spelling Sentry displays a file-open dialog. Locate and select the file containing the lexicon you 

wish to open, then select the OK button.
4. Spelling Sentry displays the new lexicon in the lexicon-editor dialog.

How to set preferences
You can change the way Spelling Sentry operates to suit your personal preference.

1. Select the Preferences item in the Options menu.
2. The Preferences dialog appears. Select the check boxes in the dialog to enable or disable 

preferences as follows:

Ignore capitalized words: Spelling Sentry will skip any words which start with a capital letter, 
unless the word is the first word in a sentence. This option is useful if your document contains 
many proper names.

Ignore words with numbers/symbols: Spelling Sentry will skip any words which contain 
embedded numbers or other non-alphabetic symbols Examples: K2J, X11, DOS6.

Report mixed-case words: Spelling Sentry will report as misspelled words which contain unusual
combinations of upper- and lower-case letters, even if the words are otherwise spelled correctly. 
Examples: PrintScreen, hAppy, CodeHead.

Report doubled words: Spelling Sentry will report as misspelled any word which appears twice 
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in a row, unless the first word appears at the end of a sentence. Example: the the.

Always suggest: When this option is selected, Spelling Sentry will always suggest alternative 
words when a misspelled word is detected. If this option is disabled, you can obtain suggested 
words by selecting the Suggest button. Disabling this option will make Spelling Sentry run faster.

Make backup copy of changed files: When this option is selected, Spelling Sentry will make a 
backup copy of any disk files changed using the Replace or Replace All buttons. The backup 
copy will have the same name as the original file, but it will end in .BAK. For example, if you 
replace words in a file called CHAP1.WRI, Spelling Sentry will leave the original contents in a 
file called CHAP1.BAK.

3. Once you have made your option selections, select the OK button.

How to exit Spelling Sentry
To exit Spelling Sentry, select the Exit item from the File menu.
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Spelling Sentry Reference

File Menu
The File menu contains file-related commands.

Check: Causes Spelling Sentry to check the spelling of words in an ASCII text file or Windows Write 
file.

Exit: Terminates the Spelling Sentry program.

Check menu
The Check menu contains entries which cause Spelling Sentry to check the spelling of files, the 
clipboard, or individual words.

File: Causes Spelling Sentry to check the spelling of words in an ASCII text file or Windows Write file.

Clipboard: Causes Spelling Sentry to check the spelling of words contained in the Windows clipboard.

Word: Causes Spelling Sentry to check the spelling of a single word.

Options menu
The Options menu contains a single item, Preferences, which you can use to display a dialog to edit 
Spelling Sentry’s options. For more information, see the “How to set preferences” section in the “Using 
Spelling Sentry” chapter.

Lexicon Menu
The Lexicon menu contains items you can select to edit the user lexicon, supplemental lexicon, or 
exclusion lexicon.

User: Displays a dialog you can use to edit the user lexicon.

Supplemental: Displays a dialog you can use to edit the supplemental lexicon.

Exclusion: Displays a dialog you can use to edit the exclusion lexicon.

Help Menu
The Help menu contains items you can select to obtain information on using Spelling Sentry.

Index: Select this item to access Spelling Sentry’s on-line help.

Search for help on: Displays a dialog you can use to search for topics in Spelling Sentry’s on-line help.

About: Displays a dialog which shows copyright information and the version number of the Spelling 
Sentry program and DLL.
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Main Window
This section describes the buttons and controls appearing in Spelling Sentry’s main window.

Context Area: The area at the top of Spelling Sentry’s window, just below the menu bar, shows the 
context in which a misspelled word is found. Usually, the context is the sentence containing the word.

Misspelled Word Field: Shows the word which Spelling Sentry considers to be misspelled.

Correction Field: Contains a replacement for the misspelled word. You can enter a correction word by 
typing it through the keyboard, pasting it from the clipboard (press Ctrl+V), or by selecting one of the 
suggested words in the Suggestions List Box (see below).

Suggestions List Box: Contains suggested alternative words which Spelling Sentry recommends as 
replacements for the misspelled word. When you select a word in the list box, it is automatically copied 
to the correction field (see above).

Words Checked Field: Displays the total number of words checked in a file or clipboard. The number 
just to the right of this field shows what portion of the file or clipboard has been checked, expressed as a 
percentage.

Add to Lex Button: Adds the word in the Misspelled Word field to the user lexicon. Use this button if the 
word which Spelling Sentry flagged as misspelled is actually correctly spelled, and is a word you use 
frequently.

Recheck Button: Causes Spelling Sentry to check the spelling of the word in the Correction field. 
Spelling Sentry displays a message indicating whether the word is correctly spelled or not. Use this 
button if you type in a word to replace the misspelled one, and want to double-check the spelling.

Suggest Button: Causes Spelling Sentry to search for replacements for the word in the Misspelled Word 
field. Use the Suggest button if you want Spelling Sentry to look up the correct spelling for a misspelled 
word. Any suggested replacements found will be displayed in the Suggestions List Box. Pressing the 
Suggest button again may yield better suggested words. When the Suggestion button is disabled 
(grayed), no further suggestions can be located.

Ignore Button: Causes Spelling Sentry to skip the current word in the Misspelled Word field.  If the word
appears again, Spelling Sentry will regard it as misspelled. Use the Ignore button if the word is actually 
correctly spelled, but probably doesn’t occur again in the file or clipboard.

Replace Button: Causes Spelling Sentry to replace the misspelled word with the word in the Correction 
field. Only this occurrence of the word is replaced. Use the Replace button if the misspelled word isn’t 
likely to appear again in the file or clipboard.

Ignore All Button: Causes Spelling Sentry to ignore this and all further occurrences of the misspelled 
word in the file or clipboard. Use the Ignore All button if the word in the Misspelled Word field is 
actually correctly spelled and probably occurs again in the same file or clipboard.
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Replace All Button: Causes Spelling Sentry to replace this and all further occurrences of the misspelled 
word with the word in the Correction field. Use the Replace All button when the misspelled word is 
likely to occur again in the same file or document.

Stop Checking Button: Causes Spelling Sentry to cancel a file check or clipboard check in progress.  
Any replacements made to the file or clipboard are lost.

Statistics
When Spelling Sentry has completed checking a file or the clipboard, it displays some statistics.

Words Checked: The total number of words in the file or clipboard.

Sentences: The approximate number of sentences in the file or clipboard. Spelling Sentry counts 
sentences by recognizing sentence-terminating punctuation (i.e., periods, question marks, and 
exclamation marks).

Flesch-Kincaid Readability Grade: A score indicating the readability of your writing, expressed as the 
approximate number of years of schooling needed to understand it.

Fog Index: Another readability score, also expressed as the number of years of schooling needed to 
understand your writing.
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Glossary

This section defines some of the terms used in this user’s guide.

Alternative word Spelling Sentry can suggest alternative words which are likely 
replacements for a misspelled word. For example, if the misspelled word 
is “stopp,” Spelling Sentry might suggest “stop,” “steppe,” “stopped,” etc.

Exclusion lexicon A word that appears in the exclusion lexicon is automatically 
considered misspelled, even if it appears in one of the other lexicons. 
Possible uses for the exclusion lexicon include:

• Flagging valid but obscure words that may occur as a result of 
typing errors (e.g., typing “tan” instead of “than”)

• Flagging frequently confused words to serve as a reminder to 
select the correct usage (e.g., “your” and “you’re”)

• Flagging overused or otherwise unacceptable words (e.g., 
“prioritize,” sexist terms, etc.)

Lexicon A lexicon is a set of words. Some spelling checkers use the 
term “dictionary” to describe the set of words they use; we prefer to 
reserve “dictionary” to mean “a set of words and their associated 
meanings.”

Main lexicon The main lexicon is a large collection of commonly used 
English words. The main lexicon is compressed and cannot be edited. A 
80,000-word main lexicon is provided with Spelling Sentry.

Misspelled word Spelling Sentry considers a word to be misspelled if it exists in the 
exclusion lexicon, or if it does not exist in the user, supplemental, or main 
lexicon.

Suggested word See Alternative word.

Supplemental lexicon Although it can be used for several purposes, the supplemental 
lexicon is intended to hold words which supplement the words in the main
lexicon — e.g., medial, legal, or scientific terminology.

User lexicon Although it can be used for several purposes, the user 
lexicon is intended to hold words which are specific to you: your family 
name, business name, street name, etc.
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